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Introduction  

This lab will have the student install, configure and explore FilesX. 

Lab Requirements  

These labs are written using IBM ® Tivoli Storage Manager v5.5 and FilesX on a Microsoft® 
Windows® 2003 operating system.  The only requirement is the virtual machine used to perform 
the labs, VMWare Workstation v5 or later (or VMWare Player or VMware Server v1 in some 
circumstances) and sufficient resources on your host machine to run the virtual machine (2 GB 
RAM is recommended).  All software needed for the labs is included within the VMWare image 
itself.   The location of all necessary files will be indicated in the lab as required.  

This lab uses the TSM Demo II VMware Image. 

Lab Objectives  

Upon completion of this lab you will be able to:  

• Install the FilesX component 

• Understand how the components work together 

• Configure FilesX for normal operations 

• Take snapshot and CDP backups of file data 

• Restore file data in numerous scenarios 

• Create a DR backup of the primary snapshot repository. 

 

Preparing for the Lab 

Start the Windows 2003 Virtual Machine  

__ 1. If the VMWare image is not already running, start it then click the Manage Snapshots 
for Virtual Machine icon at the top of the page.  

 

__ 2. Select the Snapshot named Snap0- Base State (see picture) and click the Go To button at 

the bottom of the panel. If you get a message to confirm you want to restore this snapshot, 

click Yes.  
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__ 3. On the left side of the screen click on Start this virtual machine. This will open a virtual 

Windows 2003 Server. If you are prompted to install drivers, click OK.  

__ 4. When the Welcome to Windows screen appears, left-click somewhere in the middle of 

the virtual screen. Use CTRL+ALT+Insert to get a sign-on screen for the virtual 

machine.  

__ 5. Log on to the virtual machine. The default ID is Administrator, and the password is 

smartway. 

__ 6. While your cursor is within the virtual machine’s window, use the CTRL+ALT+Enter 

key combination to put the host in full screen mode.   
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Exercise 1 – Installing and Configuring FilesX Server 

Introduction  

In this exercise you will install and configure FilesX Server. 

Install FilesX Server 

__ 1. Start Windows Explorer from the System bar.  Navigate to S:\IBM 
Software\FilesX\Xpress Restore. Double-click on Setup.exe. 

__ 2. Click Next at the Welcome screen. 

__ 3. Review the Introduction screen and click Next. 

__ 4. Accept the license agreement by clicking Yes. 

__ 5. Click Next to accept the default installation directory. 

__ 6. Click Next to accept the default Program Folder. 

__ 7. Choose Backup Server for the installation type, click Next. 

__ 8. During the install, you will see a popup asking for authorization to install a new driver.  

Click Yes to authorize the installation of the FilesX Virtual Volume driver. 

__ 9. When asked, validate Yes, I want to restart my computer now is selected and click Finish. 

 

Add Repository Space to the FilesX Server 

__ 1. After the system restarts, Log In again using a CTRL-ALT-INSERT key combination 

and the account Administrator with the password smartway. 

__ 2. You will notice the system bar is not visible.  You can make it so by using your cursor to 

stretch it upwards. 

__ 3. Start the FilesX Xpress Restore manager using the Start button → All Programs → 
XpressRestore → Xpress Manager menu path.  If you receive any errors stating the 

interface was unable to initiate, simply wait 2-3 minutes and try again. 

__ 4. Once the login screen starts, you will see the message Loading configuration…  After it 

changes to Loading completed you can log in with the user name admin and the password 

admin123. 

__ 5. Click Cancel at the welcome screen which asked if you wish to add storage to a 

repository. 

__ 6. On the left side of the interface you will see a navigation tree.  Expand that tree next to 

General Configuration. 

__ 7. Click on the node Storage Pool. 
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__ 8. In the bottom of the right-hand section of the GUI, you will a list of all volumes on the 

system and the partitions that reside upon them.  Scroll down until you see the Local 

Repository partition. 

__ 9. Right-Click on the volume (not the existing partition) and select Add to repository (see 

Picture). 

 

__ 10. You will be warned that the data will be lost.  Click Yes to continue.   

__ 11. You will be asked again if you are certain you wish to add this volume (BasicDisk-

10006).  Click Yes again. 

__ 12. Click Apply at the next window which will add all of the volume’s space to the 

repository. 

__ 13. You will be told the space will be added to Xpress Restore, will warn you not to use it for 

anything else and also that you should configure your Anti-Virus software to not scan this 

data area.  Click OK. 

__ 14. While the volume is formatted and added to the repository, you will lose connectivity to 

the Xpress Restore Server.  You can validate this by looking at the right-most status icon 

on the GUI (see Pic). 

 

__ 15. When the server restarts and reconnects, you will see the icon change.   

 

__ 16. When the manager and server reconnect, click on Storage Pool again.  You will see that 

you can now expand the tree next to Storage Pool.  Do so. 

__ 17. You will see a Repository Pool node.  Click on it.  You will see that the volume we 

selected earlier is now part of the Xpress Restore snapshot repository.  You will also see 

that it created a new partition on that volume and formatted it with an NTFS file system.   

__ 18. Start Windows Explorer, expand My Computers and click on the H: drive (REP_H).  

You will see first that this repository is shared to other users on the network.  You will 

also see various control files within the repository. 
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Configure FilesX Server 

__ 1. Return to Xpress Manager and click on the General Configuration node in the 

navigation tree. 

__ 2. You will see a settings workbook on the right side of the GUI, started at the General tab.  

Review this tab (note that the system date/time of the virtual machine is different than 

your physical host, this is intentional).   

__ 3. Click on the Applications tab.   FilesX has the option of quiescing MS SQL and MS 

Exchange.  It can do this using VSS (on 2003 and current application versions) or using a 

custom Application Quiescing module for earlier software.  Check the boxes for VSS 
Flush and Purge Exchange logs after completed snapshot.  Click the Apply button in 

that section of the page.  You can also see some timeout parameters can be specified on 

this page. 

__ 4. Click the Maintenance tab.  FilesX will do free-space maintenance on its snapshot 

repository by consolidating snapshot data once that data is no longer required.  For now, 

just review but do not change these settings. 

__ 5. Click on the Retries tab.  You can see that we can customize how many attempts FilesX 

will make when taking a snapshot. 

__ 6. Click the Licenses tab.  You will see this software will expire after 13 days if we do not 

add a license.    Click on the File main menu item and select Upload License File. 

__ 7. Navigate to S:\IBM software\FilesX\license and select nosupport.dat. 

__ 8. Click License Upload and Yes to allow the Xpress Restore server to be reset. 

__ 9. Monitor the bottom-right icon and watch the Xpress Restore server stop and restart.  

When the connection is restarted, you will need to click on General Configuration again 

to get to the properties workbook.   

__ 10. Click the Network Configuration tab.  You will see that an IP address is dedicated for 

the Xpress Restore server.  You have the option to assign another NIC to file-level 

recovery.  We will not need to do this in this lab. 

__ 11. Click on the Xpress Mount Access tab.  This will allow you to limit who can access the 

FilesX repository to do recoveries. 

__ 12. Click on the Remote Repository Access tab.  You can add remote disk to the repository 

(such as may be served up by a NAS box).  We will not do this in this lab. 

__ 13. Click on the FXP Configuration tab.  This will allow us to configure Disaster Recovery 

replication of the snapshot repository, but that will be done later in the lab. 

__ 14. Click the Alerts tab.  This tab allows us to configure Xpress Restore to use a SMTP server 

to send alerts via e-mail.  We do not do this in our lab. 

__ 15. Expand the Users and Groups node on the main navigation tree. 

__ 16. Expand Users.  You will see we have just one internal user configured to FilesX.  Right 

click on Users and select New User.  You will see that we can define a new user into a 

SuperUser group or a read-only group (LimitedGroup).  Click Cancel. 
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__ 17. Expand the Groups node.  You will see the two pre-defined groups to which we can add 

an internal user.  Right-click on Groups and select New Group. 

__ 18. Click on the Yellow Arrowhead next to Show Permissions.  You will see that you can 

make custom user groups with specific capabilities.  Click Cancel. 

__ 19. Right-click on AD Groups and select New AD Group. 

__ 20. Type in FX Restore Master and click Apply.  FilesX allows existing Active Directory 

groups to be granted Super User authority.  The FX Restore Master Active Directory 

group had previously been defined and the Administrator user added to the group. 

__ 21. Close Xpress Manager to allow the next exercise to begin. 

 

Exercise 2 – Installing FilesX Client software 

Introduction  

In this exercise you will install FilesX Client software. 

Install FilesX Client software 

__ 1. Start Windows Explorer from the System bar.  Navigate to S:\IBM 
Software\FilesX\Xpress Restore. Double-click on Setup.exe. 

__ 2. Since we had previously installed the Backup Server components using this setup 

program, the first screen will ask us if we wish to uninstall or modify the current 

installation.  Make certain Modify is checked and click Next. 

__ 3. You will be presented a list of modules, most of which are already checked since we 

installed them already. Check Xpress Client and click Next.  Do not uncheck any that are 

already checked. 

__ 4. The client installer will ask you for name of the restore server.  Leave TSM-DEMO and 

click Next. 

__ 5. During the install, you will receive a message to manually register the VSS module.  Click 

OK.   This error is an uncommon problem caused by the complex set of software that we 

have installed within this Virtual Machine in order to support a very wide variety of 

demonstrations.  You will be asked if you wish to restart the machine.  For now, do not 

respond. 

__ 6. Open a Windows Command Prompt using the C:\ icon on the system bar.  

__ 7. Issue the command:  

cd \Program Files\FilesX\XpressRestore\XPress Client\ 

__ 8. Issue the command: 

register_app.vbs –register XR_VSS XpressRestoreVSS.dll 

XR_VSS 
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__ 9. Return to the Xpress Restore setup screen, make certain that Yes, I want to restart my 

computer now is checked and click Finish. 

Exercise 3 – Performing a Snapshot Backup 

Introduction  

In this exercise you will define what you want to protect, when it will be protected and how its 

backups will be managed.  You will then watch those policies in action. 

 

Define a Snapshot Backup 

__ 1. After the system restarts, log in again using the CTRL-ALT-INSERT key combination 

and the user administrator with the password of smartway. 

__ 2. You will need to resize the system bar again to make it visible. 

__ 3. Start the FilesX Xpress Restore manager using the Start button → All Programs → 
XpressRestore → Xpress Manager menu path.  If the interface fails to initiate, just try 

again in 2 minutes or so.  The Xpress Manager interface attempts to gather Active 

Directory information, which takes a few minutes to become available. 

__ 4. Log into Xpress Manager using the account administrator with the password smartway 

from the domain DemoDomain. 

__ 5. Expand the General Configuration node in the main navigation tree.   

__ 6. Expand the Storage Pool node in the main navigation tree.  You will see that the client 

tsm-demo is now listed. 

__ 7. Right-click on the Client Group node in the main navigation tree.  Select New Client 
Group. 

__ 8. In the Client Group Name field, enter File Data CG. 

__ 9. Expand the volume selection tree by tsm-demo. 

__ 10. Check the G: drive (this volume only contains file data). 

__ 11. Click Apply. 

__ 12. Right-click on Job Schedules in the main navigation tree and select New Job Schedule. 

__ 13. Enter File Data BU Schedule for the Job Name. 

__ 14. Check the Run once a day at: button and enter a time 2 hours from now. 

__ 15. Check the Application Aware button.  You will see the global application aware settings 

we chose earlier are already specified.  Click Cancel. 

__ 16. Click the Advanced button.  You will see we can specify when the snapshot starts, if it is 

to run within a small window only or run only a specified number of times.  The Content 

aware snapshot box should be checked, which tells FilesX to not backup empty blocks.  

Click Cancel. 
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__ 17. Click Apply to save the job schedule. 

__ 18. Right-click on the Policies node on the main navigation tree and select New Policy. 

__ 19. In the Add/Define a Client Group page, click the Use an Existing Client Group tab. 

__ 20. Select File Data CG and add it to the list of client groups with the Add-> button.  Click 

Next.  

__ 21. In the Add/Define a Job Schedule page, click the Use an Existing Job Schedule tab. 

__ 22. Select the File Data BU Schedule and the Catalog schedule and click Add-> them both, 

one at a time. 

__ 23. Click Next. 

__ 24. In the Policy Name field enter File Data BU Policy. 

__ 25. Note that Enable DR is checked.  Leave it that way.  In this screen you can also modify 

the job schedules and client groups selections from the earlier pages. 

__ 26. Click on the Pre/Post Processes tab.  Here you can specify scripts that can be run at key 

points during the snapshot process. 

__ 27. Click on the Policy Cleanup tab.  Here you can specify a custom cleanup policy for this 

policy’s data.   

__ 28. Click Finish. 

__ 29. Click the Pending Jobs node of the main navigation tree.  You should show a pending 

backup for the G: volume starting today and running each day forever. 

Note:  In this exercise, we defined what will be protected, when it will be protected and how its 

backups will be managed.  As you have seen multiple client groups and schedules can be tied 

together with a policy for any combination of data protection you might wish. 

 

Run and Test the Snapshot Backup 

__ 1. Expand the Policies node in the main navigation tree.   

__ 2. Right-click on File Data BU Policy and select Run Full Snapshot. 

__ 3. Click on the Snapshots Monitor tab above the main navigation tree.  You will see a 

snapshot run and complete in short amount of time.  The filled-in green checkmark means 

the backup ran successfully and was cataloged. 

__ 4. Open Windows Explorer using the icon on the system bar. 

__ 5. Expand My Computer and File Volume (G:). 

__ 6. You will see a directory named Example Data.  Click on that directory. 

__ 7. There is a file named ChangeMe.txt in this directory.  Double-click on it. 

__ 8. Add a line indicating it is the first change and the current system time.  Save and close 
the file. 

__ 9. Delete the two files named DeleteMe.txt and DeleteMeToo.txt. 
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__ 10. Close Windows Explorer. 

__ 11. Return to Xpress Manager.  Right-click on the Full snapshot we just ran and select 

Restore → Snapshot Volume Restore.  

__ 12. To restore to the original location, expand next to TSM-Demo and select G:.  Click 

Apply. 

__ 13. You will be asked if you really want to restore G: into G:. Click Yes. 

__ 14. You will be asked again to confirm.  Click Yes. 

__ 15. The software will recommend that you bypass anti-virus scanning of this volume during 

its restore.  Click OK.  You will see the restore run and complete.  If you receive any 

message about open handles on the volume, make certain to close Windows Explorer then 

retry. 

__ 16. Return to G:\Example Data using Windows Explorer.  You will see DeleteMe.txt and 

DeleteMeToo.txt were restored.   

__ 17. Open ChangeMe.txt.  You will see that the first change you made was undone.  Add 

another change with a timestamp. 

Use Xpress Mount to Recover Individual Files 

__ 1. Launch Express Mount by double-clicking its icon on the system tray (see picture).  The 

window may start in the background. 

 

__ 2. Xpress Mount must locate the Xpress Restore repositories from which to read the 

snapshots.  Click the Refresh button.  Restore Xpress Mount using its icon.  The 

repository on TSM-DEMO@DemoDomain will be displayed.  You can also select the 

policy, host, volume and date of the snapshot you wish to mount.  Since we have only 

taken one snapshot, this is the only viable selection.   

__ 3. Click the Mount button. 

__ 4. You will be asked where to mount the snapshot.  Just leave I: selected and click OK.  A 

message will be showing indicating the mount has taken place.  

__ 5. Restart or restore Windows Explorer.  Navigate to the I: drive.  Review the contents of 

Example Data. 

__ 6. Copy ChangeMe.txt to the desktop using Drag-n-Drop. 

__ 7. Open ChangeMe.txt to view the original contents of the file. 

__ 8. Close Windows Explorer. 

__ 9. Return to Xpress Mount and click Dismount All. 

Note:  Take a moment and think about what we just did.  We accessed a snapshot while it was still 

in the Xpress Restore Server’s repository. Without having done a recovery of the snapshot, we can 
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still review its contents, copy files wherever we wish, etc.  Keep in mind that Xpress Mount can 

run on any Windows machine on the network by accessing the repository via its share.  We can 

also access the data while it is being restored using the Instant Restore feature of Xpress Mount.  

Since this volume has very little data it is difficult to demonstrate this feature at this time so we 

will defer that exercise until later. 

 

Exercise 4 – Performing a Continuous Data Protection 
Backup 

Introduction  

In this exercise you will modify the previous snapshot backup to include Continuous Data 

Protection (CDP). 

 

Define a CDP Backup 

__ 1. Return to Xpress Manager and the Configuration tab. 

__ 2. Expand Job Schedules and click on File Data BU Schedule. 

__ 3. In the job definition page, check the Enable CDP box.  You will be warned that CDP is 

not supported on Dynamic Disks.  Click OK. 

__ 4. In the Run once a data at: field enter the current system time plus 2 minutes. 

__ 5. Click Apply. 

__ 6. Click on Pending Jobs in the main navigation tree.  You should see a job scheduled to 

run today within 2 minutes (keep in mind the system date will not be the current date). 

__ 7. Click on the Snapshot Monitor tab.  You will see a snapshot backup run and complete.  

Notice that the checkmark next to the job State will have a C to indicate that this snapshot 

invokes CDP when it completes. 

__ 8. Open up Windows Explorer and return to G:\Example Data. 

__ 9. Open ChangeMe.txt.  Enter a line indicating it is change #1 and the current system 
time.  Go to File menu item and click on Save.  Keep note of the time you made the first 

change.  ________________ 

__ 10. Wait 2 minutes. 

__ 11. Add another line, indicating it is change #2 and include the current system time.    Save 

the contents using the File menu again.  Take note of the time.   ______________ 

__ 12. Wait another 2 minutes. 

__ 13. Add a third line, indicating it is change #3 and include the system time.  Close the editor 

and save the file contents.  Take note of the time.  _________________ 

__ 14. Close Windows Explorer. 
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__ 15. Return to the Snapshot Monitor tab of Xpress Manager.  Right-click on the snapshot 
you just ran and select Restore -> CDP Volume Restore.   

__ 16. In the Destination page, expand TSM-Demo and select G:.  Click Next Step. 

__ 17. You will be shown a slider bar that allows you to choose the point-in-time to recover.  

Move the slider to a time 1 minute after your second change.  For example, if you made 

change #2 at 14:15, move the slider to 14:16. 

__ 18. Click Restore.  Respond to the confirmations and warnings. 

__ 19. You will be returned to the Snapshot Monitor page.  Wait until the restore completes. 

__ 20. Open Windows Explorer and navigate to G:\Example Data again.  Open 

ChangeMe.txt.  You should see change #2, but not #3. 

Note:  Continuous Data Protection offers a great deal of flexibility in data recovery, but the 

differences between the consistency of snapshot backups and CDP need to be understood, 

particularly in the context of the specific applications you are protecting.  For example, using our 

editing application, if we had not saved our changes each time we made them, this exercise would 

not have worked. 

Exercise 5 – Disaster Recovery Replication 

Introduction  

In this exercise you will set up DR replication to a remote site. 

Configure the FTP server and the DR Hub service 

__ 1. Close Xpress Manager. 

__ 2. Using Windows Explorer from the System bar.  Navigate to S:\IBM 
Software\FilesX\Xpress Restore. Double-click on Setup.exe. 

__ 3. Since we had previously installed the Backup Server and Backup Client components using 

this setup program, the first screen will ask us if we wish to uninstall or modify the current 

installation.  Make certain Modify is checked and click Next. 

__ 4. You will be presented a list of modules, most of which are already checked since we 

installed them already. Check Central Control Station and Xpress DR Hub Server and 

click Next.  Do not uncheck any that are already checked. 

__ 5. When the install is complete, click Finish. 

__ 6. Open a Windows Command Prompt using the icon on the system bar. 

__ 7. Issue the command:  FTP tsm-demo   

__ 8. When prompted enter administrator for the account and smartway for the password. 

__ 9. Issue the command: put install.xml 

__ 10. Issue the command: quit 
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__ 11. Move to the R:\Drrepository directory by issuing the command: cd /d 
r:\DRRepository 

__ 12. List the contents of this directory by issuing the command: dir  You will see that the file 

we transferred a moment ago is in this directory.  We have a FTP server set up on this 

virtual machine and R:\DRRepository is its root directory. 

__ 13. Issue the following commands to create directories to store Xpress DR data: 

mkdir Logs 

mkdir LogEvents 

mkdir REP_tsm-demo 

__ 14. Change to the Xpress DR Hub server program directory by issuing the command: cd /d 
c:\program files\filesx\xpressrestore\xpress dr hub server\ 

__ 15. Edit the DR Hub Server configuration file by issuing the command: Write 
XpressDRServer.ini 

__ 16. Locate the line with the parameter ListenPath1.  Uncomment the line by deleting the ; 
character at its beginning.  Change c:\ListenPath1 to R:\DRRepository. 

__ 17. Locate the line with the parameter FTPRootPath.  Uncomment this line as well and 

modify its value to R:\DRRepository. 

__ 18. Close and save the file. 

__ 19. Stop and start the Xpress DR Hub service by issuing these commands: 

net stop “xpress dr hub server” 

net start “xpress dr hub server” 

__ 20. Restart Xpress Manager and log in. 

__ 21. Click on General Configuration. 

__ 22. Go to the FXP Configuration tab. 

__ 23. Enter the following parameters on this page: 

Server: tsm-demo 

Username: administrator 

Password: smartway 

Confirm Password: smartway 

Branch Name: tsm-demo 

Compression: Check 

Encryption:  Unchecked 

__ 24. Click Apply. 

__ 25. Click Test configuration.  Click Yes when told the test will only use the applied values. 

__ 26. You should receive a message that the test was successful. Click OK. 
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__ 27. Start an ad hoc DR replication by clicking the Run now button (this will start a 

background task with no message). 

__ 28. After 2-3 minutes, you will see the first monitoring icon at the bottom of Xpress Manager 

change to show that DR replication is active.  You can hover over that icon to see status 

and statistical information (see pictures). 

 

 

 

__ 29. Click on the DR Scheduler button in the properties workbook.  You can see that DR 

replication can be scheduled at any time of the day, be set to run specific days, etc.  Click 

Cancel to close this page. 

__ 30. Using Windows Explorer, look at the contents of R:\DRRepository\REP_tsm-demo.  

You will see that the data within the onsite snapshot repository is being replicated to the 

offsite location.  Since we configured the DR Hub Server, it is monitoring the location of 

the transferred data and uncompressing it to the original format. 

__ 31. Start the Central Control Station using the Start button → All Programs → Xpress 
Restore  → Central Control Station menu pathway. 

__ 32. When Central Control starts, it will ask you to either connect to a Vault or to a Share.  

Click on the Connect to Share tab. 

__ 33. Under Share Snapshots Path enter d:\drrepository\logs.  Click OK. 

__ 34. In the main navigation tree, you will see tsm-demo listed under the Xpress Restore 

Servers.  Click on it.  You will see information propagate into the Replication Status and 

Snapshots table.  Central Control Station allows you to monitor a large number of Xpress 

Restore servers using the information stored in the DR repository and log directories. 

__ 35. Close Central Control Station. 

Note: Since Xpress DR replicates its data to a central site but does not change the nature of the 

repository itself, you can begin doing restores immediately from that repository in a Disaster (or 

DR Test). 

Exercise 6 – Performing an Instant Restore (Optional) 

Introduction  

In this exercise you will restore one of your snapshot backups using the FilesX Instant Restore 

capability.  Since the volume used in this lab contained very little data, this Instant Restore 

exercise is not very compelling.  If you are going to do the FilesX labs for MS SQL Server or MS 

Exchange, we suggest you skip this exercise and perform the instant restore exercise(s) from one 

or both of those labs. 
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Perform an Instant Restore 

__ 1. Bring up the Windows Service control applet using the Start button → Administrative 
Tools → Services menu pathway. 

__ 2. Within the Services control applet, scroll down until you find the XpressClient services.  

Stop that service. 

__ 3. Start Windows Explorer and expand My Computer so all drives are listed.  Do not 

select any specific drive at this point. 

__ 4. Invoke the Xpress Mount client using its icon on the system tray.  If necessary, click 

Refresh to allow the local repository to be displayed (If you had to Refresh, you will need 

to click on the icon again). 

__ 5. Position Xpress Mount so that the list of drives in Windows Explorer is visible. 

__ 6. When you have the Xpress Mount client started and pointed to a repository, it will 

automatically list the Policy you created earlier, the local Xpress Restore server, the 

volume we previously backed up and the most recent snapshot date.  If you explore the 

snapshots in the Date menu, you will see you can select any snapshot previously taken as 

well as just specifying the Last Snapshot.   Choose any snapshot you wish to restore. 

__ 7. At the bottom of the Xpress Mount GUI, you can start an Instant Restore by clicking the 

Restore button. 

__ 8. Select G: to act as the destination of the Instant Restore.  Click OK. 

__ 9. When warned the volume will be overwritten, click Yes to continue. 

__ 10. Monitor the messages in the Instant Restore box.  You will notice that the G: drive is 

dismounted and the snapshot from within the repository is mounted for access while it is 

being restored.  You will also see the G: drive disappear and then reappear in Windows 

Explorer as the original was dismounted then the snapshot was mounted. 

__ 11. While the restore is still taking place, use Windows Explorer to navigate to G:\Example 
Data.  Open, modify and save ChangeMe.txt. 

Note:  Since this Instant Restore happened so quickly, let’s review what occurred.  You were able 

to perform a volume restore but access the data while the restore was taking place.  You had full 

read/write access to the volume the entire time.  Consider this capability in the context of large file 

systems.  You now have near-instant recovery of very large amounts of data without having to use 

hardware-based snapshot recovery capabilities. 

 

Exercise 7 – TSM Integration (Optional) 

Introduction  

In this exercise you will run through the process of integrating FilesX with TSM. 
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Manual Example 

__ 1. Bring up the Windows Service control applet using the Start button → Administrative 
Tools → Services menu pathway. 

__ 2. Start the Xpress Client service. 

__ 3. Using Xpress Mount, mount the last snapshot of the G: volume as I:. 

__ 4. Start the TSM GUI Client using the Start button → All Programs → Tivoli Storage 
Manager → Backup/Archive GUI menu pathway. 

__ 5. Click on the Backup button. 

__ 6. Expand the Local node on the navigation tree. 

__ 7. Check the gray box next to \\tsm-demo\$i (I:File Volume). 

__ 8. Click the Backup button. 

__ 9. After the backup is complete, click the OK button and close the Detailed Status Report. 

__ 10. Click the Restore button. 

__ 11. Expand the File Level node.  You will see the I: volume we just backed up. 

__ 12. Explore the contents of the I: drive and you will see the same contents as on the snapshot 

of the G: drive we just backed up. 

Note: In this example, we saw that we can backup data to TSM without any problems or 

loss of data.  However, there are 2 problems with this example.  First, it was manual 

instead of automatic.  Second, we have to know that the I: drive on this host represents the 

G: drive (possibly from another host).   

Automatic Example with SnapshotRoot Correlation 

__ 1. Close the TSM B/A GUI. 

__ 2. Return to Express Mount and Dismount the I: drive by selecting that line and clicking 

Dismount. 

__ 3. Start Windows Explorer and navigate to C:\Program Files\FilesX\XpressRestore\TSM 
Integration Example. 

__ 4. You will see 3 scripts.  Right-click on mount_g.cmd and select Edit. 

__ 5. Review the contents and find the comment “Example of Mounting a snapshot using 

Xpress Shell”.  The following line contains a command that will mount the last snapshot 

of the G: volume to a directory called U:\mounted_g.  Close the editor. 

__ 6. Right-click on mount_g.cmd again and select Open to run the script. 

__ 7. Use Windows Explorer and navigate to U:\mounted_g.  You will see the contents of the 

G: volume’s last snapshot. 

__ 8. In Windows Explorer, return to C:\Program Files\FilesX\XpressRestore\TSM 
Integration Example. 

__ 9. Right-click on Backup_G_to_TSM.cmd and select Edit. 
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__ 10. Look at the second to last line in the script.  This script will run a simple Incremental 

backup to TSM.  What is somewhat unusual is the use of the SnapshotRoot parameter.  

This tells TSM to backup the G: drive, but use a snapshot of that volume mounted at 

U:\Mounted_G.  This parameter allows us to use the snapshot backup as the source, but to 

understand which volume this snapshot belongs to. 

__ 11. Close the editor, right-click and select Open to run the backup. 

__ 12. Review the contents of the dismount_g.cmd script as well and execute it when you are 

satisfied. 

__ 13. Restart the TSM GUI Client using the Start button → All Programs → Tivoli Storage 
Manager → Backup/Archive GUI menu pathway. 

__ 13. Click the Restore button. 

__ 14. Expand the File Level node.  You will see the G: drive we just backed up using its 

snapshot as the source of the data.  If desired, explore the backup data.   

__ 15. Close the TSM B/A GUI Client. 

Note: Since we only use a single virtual machine in this exercise, we cannot demonstrate 

using a second host to backup the snapshots.  However, in a real world scenario you can 

use any host of the same OS to backup any other hosts snapshot backups and still maintain 

the ownership of the backup (using the TSM AsNode parameter) and the original source 

(using the SnapshotRoot parameter).
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Appendix A. IBM TechWorks  

TechWorks is worldwide team serving IBM software sales, technical, and development 
professionals and through these organizations our customers and partners. The TechWorks 
organization works to:  

• Provide implementation, execution and expertise for brand and general technical sales 
strategies and objectives. 

• Provide deep technical and product knowledge directly to customers and partners. 

• Create material to teach our field teams, our partners, and our customers about what IBM 
products can do.  

• Operate world-class, high-quality facilities that support and enhance the interactions 
between our field technical sales team and our customers and partners. 

For more information about IBM TechWorks, talk with your IBM sales representative. 
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Appendix B. Notices 

Consult your local IBM representative for information on the products and services currently 
available in your area. Any reference to an IBM product, program, or service is not intended to 
state or imply that only that IBM product, program, or service may be used. Any functionally 
equivalent product, program, or service that does not infringe any IBM intellectual property right 
may be used instead. However, it is the user's responsibility to evaluate and verify the operation 
of any non-IBM product, program, or service. 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION 
"AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow 
disclaimer of express or implied warranties in certain transactions, therefore, this statement may 
not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in new editions of 
the information. IBM may make improvements and/or changes in the product(s) and/or the 
program(s) described in this information at any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and 
do not in any manner serve as an endorsement of those Web sites. The materials at those Web 
sites are not part of the materials for this IBM product and use of those Web sites is at your own 
risk. 

IBM may not offer the products, programs, services or features discussed herein in other 
countries, and the information may be subject to change without notice.  

General availability may vary by geography. 

IBM may have patents or pending patent applications covering subject matter in this presentation. 
The furnishing of this presentation does not give you any license to these patents. Send license 
inquires, in writing, to IBM Director of Licensing, IBM Corporation, 500 Columbus Avenue, 
Thornwood, NY 10594. 

All statements regarding IBM's future direction and intent are subject to change or withdrawal 
without notice, and represent goals and objectives only. 

Any performance data contained in this document was determined in a controlled environment. 
Results obtained in other operating environments may vary significantly. 
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Appendix C. Trademarks and copyrights 

IBM, the IBM logo, Domino, Lotus and Tivoli are trademarks of the International Business 
Machines Corporation in the United States, other countries or both.    

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other 
countries, or both. 

Other company, product and service names may be trademarks or service marks of others. 

 

© International Business Machines Corporation 2007, 2008. All Rights Reserved. 

 

 

 


